
 

 



 
 

 

About NexSens 
NexSens Technology, Inc. was founded in the late 1990s with a mission to 
advance the capabilities and simplify the development of environmental 
monitoring systems. The company specializes in environmental sensors, 
remote data acquisition and communications technology, easy-to-use 
computer software, and web based datacenters.  
 
iChart Software is an easy-to-learn, easy-to-use Windows-based software 
program designed to interface with the industry’s most popular 
environmental monitoring sensors and systems. A large multi-vendor 
instrument library makes setup quick and easy. iChart automates much of 
the tedious programming, data collection, and manual data processing 
common with other environmental data collection systems. 
 
The SDL500 (Submersible Data Logger) and iSIC (Intelligent Sensor 
Interface and Control) are state-of-the-art data loggers that simplify the 
collection of real-time data from environmental sensors and monitoring 
instruments. The data loggers support multi-vendor sensor connections 
and are specifically designed for environmental data monitoring.  
 
WQData PRO is an enterprise class and business critical web-based 
software solution for environmental data management. It assists with 
collecting, storing, analyzing, interpreting, sharing, and publishing 
environmental data. The datacenter effectively manages a wide variety of 
biological, physical, and chemical parameters, along with many other 
environmental observations and project information. 
 
WQSensors smart USB-based sensors include: Temperature, pH, ORP, 
Dissolved Oxygen, Ammonium, Bromide, Calcium, Chloride, Fluoride, and 
Nitrate. An integral USB connector on the sensor cable offers a simple, 
hassle-free connection to a computer without the need for a meter or 
batteries. 
 
T-Node temperature systems, based on sensorBUS technology, provide a 
simple, yet effective, plug-and-play solution for developing multi-sensor 
networks and temperature strings. sensorBUS was developed to replace, 
expand, and enhance centralized parallel wiring for prevailing analog and 
digital signal transmissions. With integral 1-wire, SDI-12 and RS-485 
interfaces, sensorBUS provides versatile sensor networking capability. 
 
Monitoring Buoys are designed to support offshore monitoring systems. 
These buoys provide a robust floating platform for inland water monitoring 
projects.  
 
NexSens products and systems simplify the setup and operation of 
environmental monitoring networks and help ensure quality data. 
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Overview 
WQSensors are water quality sensors with a direct USB 
interface, providing a connection without meters, batteries, 
or power supplies. WQSensor water quality measurement 
parameters include bromide, calcium, chloride, fluoride, 
ammonium, nitrate, dissolved oxygen, oxidation-reduction 
potential, pH, and temperature. 

WQSensors such as the WQ-FL fluoride sensor that use ion 
selective electrodes incorporate a refillable double junction 
reference electrode with user replaceable sensing module. 
Each sensing module is composed of an ion-specific 
membrane. A measurement of the electric potential created 
across the membrane by specific ions is compared to the 
reference electrode, and a net charge is calculated. This net 
charge is directly proportional to the concentration of the 
specific ion. 

WQSensors Software provides an interface to calibrate, log, 
and analyze data. Data for up to four sensors can be 
displayed in real-time, and reports that include graphical 
data representations and statistical summaries can be 
generated automatically. The software also includes a 
science library with an interactive periodic table, unit 
converter, and other useful science utilities.  

 

Figure 1: WQ-FL fluoride ISE sensor 
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What’s Included 
The WQ-FL Fluoride ISE Sensor includes the following 
accessories and spares to get started and keep the unit 
operational: 

 WQSensors software & science library CD 

 Fluoride standard solution, 1000 ppm as F-, 30 mL 
bottle 

 Fluoride ionic strength adjuster (ISA) solution, Total 
ionic strength adjustment buffer (TSIAB), 30 mL bottle 

 Fluoride reference filling solution, 10% KNO3, 30 mL 
bottle 

 ISE sensor storage cap 

 Quick start guide 

Common Accessories 
Table 1: Accessories commonly used with the WQ-FL fluoride sensor 

Part Number Description Details 
FL12 Fluoride ISE 

module 
User replaceable 
threaded fluoride ISE 
electrode 

WQ-A Sensor arm Used for hands-free 
measurements for up 
to five WQSensors 

WQ-PLATE Stir plate Magnetic stir plate 
used to automatically 
stir samples during 
measurements  

WQ-STIR Micro-stirrer Used with the WQ-
PLATE to stir samples 
near the sensor 

SD0FL2-500 Fluoride standard 
solution 

Used for sensor 
calibrations, 1000 
ppm, 500 mL 

AJ0FL1-125 Fluoride ionic Used to ensure 
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strength adjuster samples and 
standards have a 
similar ionic strength, 
125 mL 

RF0FL1-125 Fluoride 
reference filling 
solution 

Used to refill the WQ-
FL reference module 

Specifications 
Table 2: NexSens WQ-FL fluoride sensor specifications 

Length 6.1 in (155 mm) 

Diameter (OD) 
Body: 0.47 in (12 mm) 

Sensor Cap: 0.63 in (16 mm) 

Cable Length 6’ 

Concentration Range 0.02 ppm (10-6 M) to saturation 

Operating Temp Range 0 to 80ºC 

Operating pH Range 
5 to 7 @ 10-6 M 

5 to 11 @ 0.1 M 

Reproducibility  ±2% 

Known Interferences OH- 

Minimum Sample Size 5 mL in a 50 mL beaker 

Getting Started 
Each WQSensor ships assembled, tested, and calibrated to 
factory specifications. To get started, insert the WQSensors 
software CD included with the sensor into a computer and 
follow the wizard to download and install the software.  

Preparing for Measurements 
When preparing to take measurements with the WQ-FL, 
follow the procedure outlined below: 

1. Remove the protective sensor cap must from the end 
of the sensor. Do not touch the sensing module 
with bare hands. 
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2. Make sure the reference fill solution level is above the 
reference fill line (see figure below). 

To add reference solution, slide the fastfill cap sleeve down 
and add solution through the hole in the sleeve. Make sure 
that no air bubbles are trapped inside the sensor before 
closing the fastfill cap sleeve. 

 

Figure 2: Typical ion selective electrode WQSensor 

3. Rinse the electrode with distilled or deionized water 
and blot dry. Do not rub the sensing module. 

4. Place the sensor tip in distilled or deionized water and 
stir for five minutes to ensure the electrode is 
completely clean. 

Measurement Techniques 
The quality of data collected depends heavily on 
measurement techniques applied. Adhere to the following 
guidelines for best results: 

NOTE 
Reference fill solution 
can be added using the 
small nozzle on the 
reference fill solution 
bottle provided with the 
sensor or alternatively 
using a small syringe 
and needle. 
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 Calibrate and measure all samples at the same 
temperature. Recalibrate if the temperature of the 
probe’s operating environment changes significantly. 

 The fastfill sleeve should be open (down) during 
measurements (see Figure 3).  

 The reference filling solution level should be higher than 
the sample level (see Figure 3). 

 The sample level should be higher than the immersion 
line on the probe (see Figure 3). 

 Do not allow air bubbles on the sensing module during 
measurements. Gently tap the sensor to remove 
bubbles if they exist. 

 Always rinse electrodes with distilled or deionized water 
between measurements. 

 Blot the sensor dry, never rub dry. 

 Stir the sample whenever possible. Stirring decreases 
the amount of time for the sensor to equilibrate and 
readings to stabilize.  

o Stir thoroughly at a slow to moderate speed 
using either a magnetic stirrer or the probe as 
the stirring rod. 

o Stirring rate should be consistent among all 
samples and standards. 

o Magnetic stirrers may generate enough heat to 
change solution temperature. A piece of 
insulating material such as cork, cardboard, or 
Styrofoam can be placed between the stir plate 
and sample container to help minimize heat 
transfer. 

 Add ionic strength adjuster to samples in a 1:1 ratio. 
For example, add 100 mL of ISA for each 100 mL 
sample. Adding ISA in a 1:1 ratio effectively masks 
interfering compounds or ions from the probe. 
Additionally the TISAB has an acetate buffer at pH 5.4, 
which helps adjust the sample pH to the appropriate 
range. 

NOTE 
Keeping atmospheric 
pressure on the 
reference fluid during 
measurements gives 
the most reproducible 
flow out of the junction. 

NOTE 
Magnetic stirrers may 
generate enough heat 
to change solution 
temperature. 
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Figure 3: Visual summary of proper measurement techniques for ISE 
WQSensors 

Computer Interface 
WQSensor Software requires the following minimum system 
configuration: 

 Pentium processor 

 64 MB RAM 

 100 MB hard drive 

 2 MB video card 
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 CD-ROM drive 

 Adobe Flash 

 Windows 2000 (SP1 or higher), Windows XP, Windows 
Vista, or Windows 7 

Following the initial software installation, USB communication 
with WQSensors will be enabled. Plug a WQSensor into an 
available USB port. Windows will automatically recognize it 
and start the Found New Hardware wizard.  

The device driver should download automatically. If it the 
computer does not find the device driver and install it 
automatically, it can be installed manually from the following 
location: 

“C:\Program Files\NexSens\WQSensor\Driver\wqsensor.inf” 

If unable to get the WQSensor device driver installed, 
contact NexSens technical support. 

Viewing Real-Time Data 
To begin viewing live data, simply plug the sensor into an 
available USB port on a computer running WQSensors 
software and click the Sensors tab.  

Data should be displayed on screen and updated once per 
second. The serial number of the connected sensor and the 
time of the last logged reading are displayed on the bottom 
of the screen. 
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Figure 4: Click the Sensors tab to view live data; the connected sensor’s 
serial number and time of last logged reading are displayed at the bottom of 

the screen 

Up to four individual WQSensors can be viewed at one time 
through the Sensors tab of WQSensors software, provided 
each one is plugged into a separate USB port on the 
computer running the software. 

 

Figure 5: Four WQSensors connected to a computer showing live data, serial 
numbers, and time of last readings  simultaneously 

Logging Data 
Data can be logged to the computer manually as single 
measurements or automatically at a user defined interval. 
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To log a single data point, click on the left hand side of the 
Log button. The left side of the button will turn blue and a 
short animation with the letter L will display on the bottom 
left hand corner of the screen. 

 

Figure 6: Click the left hand side of the Log button to manually log a single 
data point 

For automatic data collection, a log interval must be 
specified. This interval can be set by clicking the Interval 
button in the Settings menu. Data can be logged as often as 
once per second. 

 

Figure 7: The log interval can be changed from the Settings menu by clicking 
the Interval button 

NOTE 
Data can be logged as 
often as once per 
second. 
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To start logging continuous measurements automatically at 
the user defined interval, click on the right hand side of the 
Log button. The entire button will turn blue and a short 
animation with the letter L will display on the bottom left 
hand corner of the screen.  

 

Figure 8: Click the right hand side of the Log button to automatically log data 
at the user defined interval 

Reporting and Exporting Data 
WQSensors software provides an interface to view data in 
raw or graphical form, automatically summarize data, 
compute statistical parameters, and export data.  

Any data that is logged can be viewed or exported by 
generating a report. To generate a report, click the Report 
button in the View tab and then follow the procedure below: 

1. Enter the desired range of time or check “Include all 
project data”. 

2. Select the sections to include in the report. Choose 
any or all of the following: “Summary”, “Statistics”, 
“Graph”, and “Data”. Fill in a Report Description and 
Author if desired. 

NOTE 
Data is exported in .csv 
(comma separated values) 
format for use with 
programs like Microsoft 
Excel. 
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Figure 9: Select sections to include in the report and input a Report 
Description and/or Author 

3. Use the drop down Sensor List menu to place a check 
box next to each sensor that that should be included 
in the report. 

 

Figure 10: Select sensors from the Sensor list drop down menu 

4. Click the Options button to include additional notes 
about the project in the report, or to “Use time as X-
axis”.  
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Figure 11: Additional report options menu including Report Notes and Graph 
Options 

5. Click Generate to create the report. Following creation, 
the report can be saved, printed, or exported to 
Microsoft Excel from the icon-based toolbar. 

 

Figure 12: Sample report generated with WQSensors software; raw data 
collected is shown on left and graphical display is shown on right 

Calibrating the Sensor 
It is recommended that calibration is done on a daily basis, 
or at least prior to each use.  

NOTE 
If the “Use time as X-
axis” box is left 
unchecked, data will be 
graphed with the 
sample # (i.e. 1st, 2nd, 
3rd sample, etc) on the 
abscissa. 
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During calibration, observe the slope of the mV readings 
between the two points that are being used for calibration. 
Slope is defined as the change in voltage read by the sensor 
with a ten-fold change in concentration (mV/decade).  

The slope of the WQ-FL sensor following a two-point 
calibration should be 58.2 ± 5 mV/decade at 25°C. Every 
±0.5°C change in temperature moves the mean value of the 
slope ±0.1 mV. 

Follow the procedure outlined below to complete a 
calibration: 

1. Dilute the 1000 ppm fluoride standard solution as 
necessary to prepare two calibration standards that 
differ in concentration by a factor of 10 and bracket 
the expected sample range.  

o Consult the “Diluting Calibration Standards” 
technical note available on the NexSens 
Knowledge Base for a step-by-step guide to 
preparing calibration standards from a stock 
standard solution. 

2. Make sure that the fluoride ionic strength adjuster 
(ISA) is added to each calibration standard in a 1:50 
ratio. For example, 2 mL of ISA should be added for 
each 100 mL of diluted calibration standard. ISA is 
not considered part of the dilution. 

3. Check that the sensor reference fill solution level is 
above the reference fill line.  

4. Plug the sensor into an available USB port on a 
computer running WQSensors software. Click the 
Settings tab and then select “Show mV values?” 

NOTE 
Always use distilled or 
deionized water for 
diluting calibration 
standards. 
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Figure 13: Click the Settings tab to enable showing mV values 

5. Click the Sensors tab and data should be displayed on 
screen as shown. 

 

Figure 14: Click the Sensors tab to display ppm and mV data 

6. Slide the fastfill sleeve on the sensor down, rinse the 
sensor tip in distilled or deionized water and blot dry. 
Keep the sensor vertical so that the reference fill 
solution does not spill out.  

7. Place the sensor in the first standard and wait 1-2 
minutes for readings to stabilize.  
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8. Click Calibrate, highlight the concentration reading in 
ppm, enter the concentration of the standard and 
press Enter or click the Calibrate button again. A 
short animation with the letter C will display on the 
bottom left hand corner of the screen. 

 

Figure 15: Enter the value of the first calibration standard and press Enter to 
accept 

9. Rinse the sensor and blot dry before placing it into the 
second calibration standard. Again wait 1-2 minutes 
for the reading to stabilize, enter the concentration of 
the standard in ppm, and press Enter.  

10.Rinse the sensor and blot dry. Close the fastfill sleeve 
and cover all calibrations standards tightly to prevent 
contamination. Calibration is complete. 

Calibration should be done as often as every one to two 
hours for maximum accuracy. Calibration drift can be 
checked by immersing the probe in a standard with a known 
concentration and letting the reading stabilize. 

Good Laboratory Practice Files 
WQSensors software automatically records every calibration 
to a Good Laboratory Practice (GLP) file. The GLP file 
includes date & time, calibration values, and mV values for 
each calibration. This file is stored on the sensor and will 
carry over between computers. The GLP files can be 

NOTE 
Temperature and mV 
values cannot be 
calibrated. 
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accessed for any sensor connected to the computer by 
clicking the GLP button in the View tab. 

 

Figure 16: Click the GLP button in the View tab to access good laboratory 
practice files. 

Project Files 
Each project file contains information about every sensor 
that was connected to the computer while that file was open, 
as well as any data that was collected during that time. 

When WQSensors software first runs, it defaults to Project_1. 
This is the default name for the first project file.  

 

Figure 17: Default screen in the File tab showing the Existing Project Profile 
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To create a new project click the New button in the File tab 
and enter a project name. Click OK when finished. 

 

Figure 18: Sample project created by clicking New in the File tab 

To open a previously created project, click Open from the 
File menu. Select the project to open and click OK. 
WQSensors software will begin using that project file as the 
current project. 

To rename the current project, select Rename from the File 
menu. Enter a new name and click OK. Only the current 
project can be renamed. 

Optional Software Settings 
Click the Application button in the Settings tab to toggle 
the Application Settings described below on or off as desired. 
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Figure 19: The Application Settings menu in the Settings tab in WQSensors 
software 

“Show introduction animation?” - displays an introductory 
animation each time WQSensors software is started. Un-
checking this box will disable animation. 

“Remember last menu location?” - specifies whether the 
WQSensors software should reload the last menu opened 
each time WQSensors software is started. Un-checking this 
box will make the Sensors menu the default page. This 
feature is useful if a specific Library menu table or formula 
is used often. 

“Convert Celsius to Fahrenheit?” - specifies whether to 
display temperature readings in Celsius or Fahrenheit. Un-
checking this box will display all temperature readings in 
Fahrenheit. 

“Show mV values” – displays mV readings from WQSensors 
in the Sensors tab. Un-checking this box will disable the 
display of mV values.  

Science Library 
The WQSensor software Library menu is a desktop 
reference for water, wastewater, and environmental 
professionals. It's packed with tables, calculations, and many 
conversions. Among the science library’s capabilities are the 
following: 

NOTE 
mV readings are not 
required to take 
measurements but are 
useful in determining 
the quality of sensor 
calibrations. 
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 Converting units of measure 

 Calculating flow over a weir 

 Determining the inside diameter of PVC pipe 

 Finding the ammonia tolerance level for rainbow trout 

 Determining the atomic weight of bromine 

 Finding the concentrations of elements in sea water 

 

Figure 20: Interactive periodic table of elements included in the Science 
Library 

 

Figure 21: Unit Conversion interface included in WQSensors software 
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Built-in Customer Support 
WQSensors software integrates the internet into part of its 
functionality. Software updates, a technical support 
interface, WQSensor user manuals, and a WQSensor 
shopping interface can all be accessed through the Help tab.  

 

Figure 22: The default menu in the Help tab provides a form for contacting 
NexSens technical support (requires an internet connection) 

If phone contact is preferable, include a note in the Message 
field of WQSensors Software Help suggesting a call back. Be 
sure to provide a phone number in this case. 

 

Figure 23: Click the Updates button in the Help tab to display the current 
version of the software 

NOTE 
Be sure to include a 
name and email 
address when 
contacting NexSens 
technical support. 
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Maintenance 
If the response time and/or quality of data collected by a 
WQSensor decrease, try cleaning and reconditioning the 
probe. If these steps do not resolve the problem, consider 
replacing the sensing module to boost performance. 

Cleaning 
The sensor can be cleaned using distilled or deionized water. 
Rinse thoroughly as necessary but avoid using any detergent 
or other cleaning products. 

Reconditioning 
A good working ISE response stabilizes within one or two 
minutes. However, the ISE can become sluggish if the 
membrane becomes dirty from grease or particles in the 
sample.  

Although the WQ-FL is a solid state ISE, it should not be 
polished in an attempt to recondition the electrode; it should 
only be rinsed thoroughly with water in an attempt to restore 
sensor performance. 

Replacing the Sensing Module 
NexSens recommends replacing the sensing module every 
six months for all ISE WQSensors to maximize measurement 
accuracy and sensor performance.  

The sensing modules are user replaceable. Removal and 
installation is quick and easy and can be done in just a few 
minutes with no tools. 

Follow the procedure outlined below to replace the sensing 
module: 

1. Remove the existing sensor module by unthreading 
the connection between the module and the probe 
body. This can be done by hand, although a 7/16” 
wrench can be used to get started if necessary. 

2. Screw the new module onto the probe body until it is 
hand tight. Do not over tighten the connection. 

WARNING 
Do not touch the 
sensing element with 
bare hands. 
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Figure 24: Exploded view of sensing module assembly 

Storage 

Short Term 

For short term storage (1-3 days), rinse the electrode 
thoroughly with distilled or deionized water and then place 
the sensor tip in a solution of ISA and distilled or deionized 
water. ISA should be added to the water in a 1:50 ratio. For 
example, add 2 mL of ISA for each 100 mL of water. 

Long Term 

The sensor electrode should be stored completely dry for any 
amount of time longer than three days. Rinse the tip 
thoroughly with distilled or deionized water, blot dry, and 
allow to completely dry out. Then place the ISE sensor 
storage cap over the end of the probe. 

During long term storage, make sure that the reference 
junction is not allowed to dry out. There must be adequate 
reference filling solution inside the probe at all times. 

Salt deposits may form on the reference chamber during 
long term storage. These can be wiped dry or cleaned off 
with warm water. 

NOTE 
There must be adequate 
reference fill solution 
inside the probe at all 
times. 
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Troubleshooting 
Follow the procedure below to isolate and resolve sensor 
problems 

Table 3: Common problems and resolutions with WQ-FL fluoride sensors 

Symptom Possible Cause Corrective Action 

Out of range 
calibration 

Considerable 
temperature 
gradient between 
standard solutions 
and reference fill 
solutions 

Soak the electrode 
in the low range 
calibration standard 
for two hours and 
recalibrate 

Contamination of 
calibration 
standards, poor 
dilution accuracy or 
distilled water 
quality, 
mathematical error 

Prepare new 
calibration standards 

Sample data is 
erroneous 

Sample pH is too 
high or low 

 

Check that the pH 
solution of the 
sample is within the 
probe’s operating 
range 

Extrapolated data Make sure that the 
expected 
concentration of the 
sample is within the 
sensor’s calibration 
range 

Samples contain 
interfering ions 

 

Use appropriate 
complexing agents 
to negate the effects 

 

If the issue persists, visit www.NexSens.com to search the 
Knowledge Base for FAQs and troubleshooting guides; 
otherwise please contact NexSens technical support.   
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Material Safety Data Sheets 
Material Safety Data Sheets can be found at: 
http://www.nexsens.com/support/msds.htm  

Warranty and Service 
NexSens Technology, Inc. warrants products against defects 
in materials or workmanship for a period of 6 months from 
the date of delivery to the original customer. This warranty is 
limited to the replacement or repair of such defects, without 
charge, when the product is returned to NexSens 
Technology, Inc. Damage due to accidents, misuse, 
tampering, lack of reasonable care, loss of parts, failure to 
perform prescribed maintenance, or accidents of nature are 
not covered. This warranty excludes all other warranties, 
express or implied, and is limited to a value not exceeding 
the purchase price of the instrument.  

Limitation of Warranty 

This warranty is not applicable to any NexSens Technology, 
Inc. product damage or failure caused by (i) failure to install, 
operate or use the product in accordance with NexSens 
Technology, Inc. written instructions, (ii) abuse or misuse of 
the product, (iii) failure to maintain the product in 
accordance with NexSens Technology, Inc. written 
instructions, (iv) any improper repairs to the product, (v) use 
by you of defective or improper components or parts in 
servicing or repairing the product, or (vi) modification of the 
product in any way not expressly authorized by NexSens 
Technology, Inc. 

Corporate Headquarters and Authorized Service Center 

NexSens Technology, Inc.  
1415 Research Park Drive 
Beavercreek, Ohio 45432 
Phone 937.426.2703 ● Fax 937.426.1125  
E-Mail support@nexsens.com 

Revision: 03 Revision Date: December 15, 2010 
 

 

WARNING 
NexSens Technology, 
Inc. products are not 
authorized for use as 
critical components in 
any life support system 
where failure of the 
product may affect its 
safety or effectiveness. 
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